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[bookmark: _Toc30092]一、接线指导
（默认已准备好认证模组，已烧录固件）
1、需要泰凌微烧录器
[image: ]
2、模块     泰凌微烧录器
3.3V ------3.3V
GND ------GND
SWS ------SWM
以BT3L为例
[image: ]
注：
1、 模组焊到整机底板，只焊接3.3、GND、SWS，其余引脚不要焊接，可能会强制拉低或拉高而导致无法进行测试；
2、 模组焊到整机底板，直接在模组引脚上焊接杜邦线；不要在底板焊接、经过底板电容等元器件会导致模组无法收发；


[bookmark: _Toc19731][bookmark: _Toc6516]二、定频测试
1、按上述接线后，下载定频测试软件：双击下方压缩包下载


2、双击打开EMI Tool，打开软件后点击SWB SP，显示红框内Swire OK则定频成功可以测试； 
[image: 图形用户界面, 文本, 应用程序, 电子邮件

描述已自动生成]
3、根据测试需要修改频率set channel、功率set power及Set RF Mode，其他不需要修改不需要点击。
[image: ]
[bookmark: _Toc25719]三、定频出现No Swire Slave Device
定频测试时点击SWB SP出现下方提示信息
[image: ]
操作如下：
1、下载下方烧录软件，双击Telink BDT点击File选择open选择kite_emi_V1.5_20180927.bin；


2、点击SWS，log反馈 [56]: TC32 EVK: Swire err!，则需要激活；
[image: 图形用户界面, 文本, 应用程序

描述已自动生成]
[bookmark: _Hlk111710637]3、激活操作如下：点击Activate，若显示Activate OK，再点击SWS, 显示TC32 EVK: Swire ok! 则再打开EMI Tool进行定频测试操作；
[image: ]
4、若激活失败，则该模块无法使用，需要更换其他模组；
[image: ]
5、若激活操作显示TC32 EVK: Swire ok! 但是EMI Tool定频测试操作仍异常，需要重新烧录固件；



[bookmark: _Toc5972]四、BQB测试
1、样机处理
1）BQB测试样机通常需要做成传导样机（去匹配、焊接射频线），烧录固件为BQB固件；
2）若需要进行BLE OTA测试，则不去掉匹配，但需要焊接杜邦线接串口板。
2、烧录固件


3、接线方式
模组    串口板
VCC ----- VCC
GND ----- GND
TX（B1）-- RX
RX（B7）-- TX
3、 BQB样机放置于屏蔽箱内（若为辐射样机则不可放入屏蔽箱）并与CMW500连接；
例图：
[image: ]
5、CMW500设置
1） Burst Type 选择Low Energy
2） PHY选1Mbps
3） HW Interface 选USB toRS232 adapter
4） EUT Common Protocol 选2 wire
5） 波特率设置为115200；
6） Pattern Type选择10101010或者PRBS9不影响连接
[image: ]
连接成功后可手动测试或按照编好的自动化脚本（使用CMWRun软件）进行测试，可以测TX、RX以及信号调制特性等。
[image: ]

注：装整机测试连接不上先试单模组是否可以测试，确定下模组是否有问题；
1
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BDT/config/bin/dut_8232_flash_v0002.bin





BDT/config/bin/dut_8233_flash_v0002.bin





BDT/config/bin/dut_8255_flash_v0002.bin





BDT/config/bin/dut_8258_flash_v0003.bin





BDT/config/bin/dut_8266_flash_v0244.bin





BDT/config/bin/dut_8267_flash_v0002.bin





BDT/config/bin/dut_8269_flash_v0002.bin





BDT/config/bin/dut_8366_flash_v0244.bin





BDT/config/bin/dut_8366_otp_normal_v0002.bin





BDT/config/bin/dut_8366_otp_v0001.bin





BDT/config/bin/dut_8368_flash_v0246.bin





BDT/config/bin/dut_8368_otp_normal_v0002.bin





BDT/config/bin/dut_8368_otp_v0005.bin





BDT/config/config.ini

[MCU]

TYPE 1 0x01 = 8366	\bin\dut_8366_flash_v0244.bin	8000	b010b010	\bin\dut_8366_otp_v0001.bin	\bin\dut_8366_otp_normal_v0002.bin	End

TYPE 1 0x02 = 8368	\bin\dut_8368_flash_v0246.bin	8000	b010b010	\bin\dut_8368_otp_v0005.bin	\bin\dut_8368_otp_normal_v0002.bin	End

TYPE 2 0x03 = 8232	\bin\dut_8232_flash_v0002.bin	8000	b010b010	End

TYPE 2 0x04 = 8233	\bin\dut_8233_flash_v0002.bin	8000	b010b010	End

TYPE 2 0x05 = 8266	\bin\dut_8266_flash_v0244.bin	8000	b010b010	End

TYPE 2 0x06 = 8267	\bin\dut_8267_flash_v0002.bin	8000	b010b010	End

TYPE 2 0x07 = 8269	\bin\dut_8269_flash_v0002.bin	8000	b010b010	End

TYPE 3 0x08 = 8255	\bin\dut_8255_flash_v0002.bin	40000	b010b010	End

TYPE 3 0x09 = 8258	\bin\dut_8258_flash_v0003.bin	40000	b010b010	End

default = 8258	End

[MODE]

MODE 0x01 = USB	End

MODE 0x04 = EVK	End

default = EVK	End

[OBJ]

OBJ	0x01 = FLASH	End       

OBJ	0x02 = CORE		End		   

OBJ	0x03 = ANALOG	End

OBJ	0x04 = OTP	End

default = CORE	End

[SIZE]

SIZE 0x01 = 1	End

SIZE 0x02 = 2	End

SIZE 0x03 = 4	End

SIZE 0x04 = 8	End

SIZE 0x05 = 16	End

default = 1	End

[DOWNLOAD_ADDR]

DOWNLOAD 0x01 = 0 End

DOWNLOAD 0x02 = 20000 End

DOWNLOAD 0x03 = 40000 End

default = 0	End

[ERASE_ADDR]

ERASE 0x01 = 0	End

ERASE 0x02 = 20000	End

ERASE 0x03 = 40000	End

default = 0	End

[ERASE_SIZE]

SIZE  0x01 = 4	End

SIZE  0x02 = 16	End

SIZE  0x03 = 64	End

SIZE  0x04 = 128	End

SIZE  0x05 = 512	End

default = 512 End

[PAGE_DISPLAY]

PAGE 0x01 = 0 Download	End

PAGE 0x02 = 1 Tdebug	End

PAGE 0x03 = 2 Log windows	End

default = 0	End

[BUTTON]

Button 1 = example1 external_exe E:\1_wtcdb\tcdb.exe uart -1 -u	End

Button 2 = example2 internal_exe 8266 wf 34000 -e 48k ;8266 rc 00 -s 10 -u; End

Button 3 = example3 external_file E:\1_wtcdb\prj\kite\doc\TS5565_AFEpin_description_v1.0.xlsx	End

/Button 4	End

/Button 5	End

/Button 6	End

/Button 7	End

/Button 8	End

/Button 9	End

/Button 10	End

/Button 11	End

/Button 12	End

/Button 13	End

/Button 14	End





[PATH]

PATH 0x01 = C:\Users\Administrator\Desktop\Telink.bin	End

PATH 0x02 = C:\Users\zhang\Desktop\TELINK8253\BDT\config\fw\Firmware_v3.2.bin End

PATH 0x03 = C:\Users\zhang\Desktop\TELINK8253\BDT\config\bin\dut_8258_flash_v0003.bin End

PATH 0x04 = C:\Users\zhang\Desktop\TELINK8253\BDT\config\fw\Firmware_v3.1.bin End

PATH 0x05 = C:\Users\zhang\Desktop\TELINK8253\8258_mesh.bin End

PATH 0x06 = C:\Users\zhang\Desktop\TELINK8253\kite_emi_V1.5_20180927.bin End

PATH 0x07 = C:\Users\zhang\Desktop\Telink8253\8258_mesh.bin End

PATH 0x08 = C:\Users\zhang\Desktop\Telink8253\tlsr_825x_sig_wcl_cct_h_0.4.bin End

PATH 0x09 = C:\Users\zhang\Desktop\Telink8253\8258_BQB_TX_A2_RX_A0_BUAD115200_20181015.bin End

PATH 0x0A = C:\Users\zhang\Desktop\Telink8253\8258_BQB_TXB1_RXB0_BUAD115200_10dBm_20190123.bin End

PATH 0x0B = C:\Users\zhang\Desktop\Telink8253\8258_BQB_TXB1_RXB7_BUAD115200_20190327.bin End

PATH 0x0C = D:\模块测试\Telink8253\A定频软件及调试说明\BDT\kite_emi_V1.5_20180927.bin End

default = 0x0C End
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1 Brief Introduction 



“Telink Burning and Debugging Tool (BDT)” applies to all engineers who want to 



develop applications based on Telink SoCs including 8267, 8269, 8266, 8232, 8233, 



8366, 8368 and 8x5x series.  



This document presents the guide on how to use “Telink Burning and Debugging 



Tool (BDT)”. 



 



1.1 Function Overview 



During SDK development, by using “Telink Burning and Debugging Tool (BDT)”, 



firmware can be directly downloaded into the target board (e.g. development board) 



via USB mode or “Burning EVK” (abbreviated as EVK) mode.           



Its main functions include “Erase flash sector”, “Download firmware”, “Activate 



MCU when communication failed”, “Access memory space including FLASH /CORE 



/ANALOG /OTP”, “Read/Write global variable” and “View USB log”. 



 



Figure 1 Main interface 
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2 Operation Guide 



2.1 Download firmware 



2.1.1 Connect hardware 



Before using “Telink Burning and Debugging Tool (BDT)”, it’s needed to connect 



the target board with PC.  



There are two methods to connect the target board with PC, as shown below. 



Method 1: Directly connect the target board with PC via USB.  



This method only applies to target board with USB interface and MCU supporting 



USB function, e.g. a dongle board. 



 



Figure 2 Directly connect target board with PC 



 



Method 2: Connect the target board with PC via Telink “Burning EVK” 



TLSR8266BR56. 



1) Connect the “Burning EVK” with PC via USB cable. Observe the indicating lights 



of the “Burning EVK”: The indicating lights will blink once to indicate that the 



“Burning EVK” and its connection with PC is OK. Te
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Figure 1 Connect “Burning EVK” with PC 



 



2) Connect target board with “Burning EVK”. 



There are two methods to connect the target board with the “Burning EVK”. 



a) Connect the target board with the “Burning EVK” via USB interface directly, 



as shown below. This connection method only applies to target board with 



USB interface and MCU supporting USB function, e.g. a dongle board. 



 



Figure 2 Connect target board with “Burning EVK” via USB 



LED 



Burning EVK 
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b) Connect the target board with the “Burning EVK” via Swire (Single wire) 



interface, as shown below.  



 



Figure 3 Connect target board with “Burning EVK” via Swire  



 



Please refer to Telink document “AN_18010500_User Guide for Telink Burning 



EVK TLSR8266BR56” for the detailed guide of TLSR8266BR56. 



 



After connecting the target board to PC via USB method or “Burning EVK” 



method, there are two methods to download firmware into the target board, which 



respectively correspond to the two hardware connection methods above.  
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2.1.2 Download FW into “FLASH” via “USB” mode  



Before using “USB” mode to download or debug MCU, please ensure that the 



specified MCU supports USB function and its USB function is available. Refer to section 



4 Function Support List for details. 



 



Then user can follow the guide in this section to download firmware into specific 



flash space of the target board via “USB” mode.   



Step1: Select chip type of the target board, e.g. 8258 (default option). The following 



two methods are supported. 



 Method 1: Use the drop-down menu to select chip type. 



 Method 2: Press the shortcut key combination “Ctrl + Q” to switch chip type.  



*Note: All chip type options and default option are configurable in the “config.ini” file. 



 



Figure 4 Select chip type  
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Step2: Select download mode as “USB”. The following two methods are supported. 



 Method 1: Use the drop-down menu to select USB download mode.  



 Method 2: Press the shortcut key combination “Ctrl + W” to switch to USB 



download mode. The drop-down menu will automatically show the current 



download mode after each switch.  



*Note: All download mode options and default option are configurable in the 



“config.ini” file. 



 



Figure 5 Select download mode as “USB” 
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Step3: Click the “Setting” button to open the Setting dialog window. Select the “FLASH” 



setting option. User can adopt either of the following two methods to set the offset of 



flash starting address for target firmware storage, e.g. 0x000000 (default option). 



 Method 1: Use the drop-down menu of “Download Addr” to select the offset 



option available.  



 Method 2: Input the offset address in the editable box of “Download Addr”.  



*Notes:  



1) All setting options and default option are configurable in the “config.ini” file. 



2) User can also configure the “SRAM”/“OTP” setting option so as to download target 



firmware to destination area in SRAM or OTP. 



 



Figure 6 Select starting offset address  
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Step4: Select the target firmware file to be downloaded into the target board.  



1) Click File->Open to open the file select window. 



 
Figure 7 Open file select window  



2) On the file select window, select the target bin file (e.g. Telink.bin) and then click 



the “Open” button. 



 
Figure 8 Select target file and open new file path 
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 The file path will be displayed at the bottom of the main interface. Every time 



when a new file path is opened via the file select window, it will be added to the 



submenu of “File->Reopen”. This simplifies FW selection in subsequent operations by 



enabling user to directly select the target file path available in the submenu of 



“Reopen”.   



 



Figure 9 Directly select target file path in the submenu of “Reopen” 
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Step5: Check connection status between the target board and the PC and make sure 



it’s OK.  



 If the status of connection is OK, the left bottom of the main interface will show 



“usb device: ok” or “evk device: ok”.  



 If the left bottom of the main interface shows “usb device: not found”, it indicates 



the connection between the target board and the PC is not available. 



 



Figure 10 Connection status indication 
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Step6: Download the selected file into the target board. 



By clicking the “Download” button, the selected firmware file will be downloaded 



into the specified flash space of the target board via USB mode. The log window will 



indicate corresponding log information, as shown below. 



 



Figure 11 Download FW into Flash via USB mode 
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Step7: Reset MCU to make the newly-downloaded program run without the need to 



power cycle MCU (unplug/plug from Burning EVK). User can follow either of the 



following two methods to make MCU boot and run. 



 If “manual mode” is selected via the drop-down menu, after FW burning user can 



click the “Reset” button at the top right corner of the tool to manually reset the 



MCU. 



 



 



 



Figure 12 Manual MCU reset 



 User can also select “auto mode” via the drop-down menu before FW burning, so 



as to enable auto reset after FW burning. 



 



Figure 13 Auto MCU reset 
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2.1.3 Download FW into “FLASH” via “EVK” mode 



Before using “EVK” mode to download firmware, please ensure that target board 



is connected to PC via “Burning EVK” method and the single wire communication of 



the target board is established.  



User can follow the guide in this section to download firmware into specific flash 



space of the target board via “EVK” mode.  



Step1: Select chip type of the target board, e.g. 8258 (default option). The following 



two methods are supported. 



 Method 1: Use the drop-down menu to select chip type. 



 Method 2: Press the shortcut key combination “Ctrl + Q” to switch chip type. The 



drop-down menu will automatically show the current type after each switch.  



*Note: All chip type options and default option are configurable in the “config.ini” file. 
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Step2: Select download mode as “EVK”. The following two methods are supported. 



 Method 1: Use the drop-down menu to select EVK download mode.   



 Method 2: Press the shortcut key combination “Ctrl + W” to switch to EVK 



download mode. The drop-down menu will automatically show the current 



download mode after each switch.  



*Note: All download mode options and default option are configurable in the 



“config.ini” file.  



 



Figure 14 Select download mode as “EVK” 
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Step3: Click the “Setting” button to open the Setting dialog. Select the “FLASH” setting 



option. User can adopt either of the following two methods to set the offset of flash 



starting address for target firmware storage, e.g. 0x000000 (default option). 



 Method 1: Use the drop-down menu of “Download Addr” to select the offset 



option available.  



 Method 2: Input the offset address in the editable box of “Download Addr”.  



*Notes:  



1) All setting options and default option are configurable in the “config.ini” file. 



2) User can also configure the “SRAM”/“OTP” setting option so as to download target 



firmware to destination area in SRAM or OTP. 
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Step4: Select the target firmware file to be downloaded into the target board.  



User can select the target file via the “File->Open”, or via the “File->Reopen” if it’s 



available in the submenu. The file path will be visible at the bottom of the main 



interface.  
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Step5: Check connection status between the target board and the PC and make sure 



it’s OK.  



 If the status of connection is OK, the left bottom of the main interface will show 



“usb device: ok” or “evk device: ok”.  



 If the left bottom of the main interface shows “usb device: not found”, it indicates 



the connection between the target board and the PC is not available. 



 
 



  



Connection status indication 
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Step6: Download the selected file into the target board. 



By clicking the “Download” button, the selected firmware file will be downloaded 



into the specified flash space of the target board via EVK mode. The log window will 



indicate corresponding log information, as shown below.  



 



Figure 15 Download FW into Flash via “Burning EVK” mode 
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Step7: Reset MCU to make the newly-downloaded program run without the need to 



power down MCU. User can following either of the following two methods to make 



MCU boot and run. 



 If “manual mode” is selected via the drop-down menu, after FW burning user can 



click the “Reset” button at the top right corner of the tool to manually reset the 



MCU. 



 User can also select “auto mode” via the drop-down menu before FW burning, so 



as to enable auto reset after FW burning. 



 



 



Figure 16 Manual MCU reset 
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Figure 17 Auto MCU reset 
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2.1.4 Download FW into “SRAM” or “OTP” 



By default, the “Setting” option is set as “Flash”, i.e. by clicking the “Download” 



button, the target firmware will be downloaded into the target board’s “Flash” space.  



User can also change the “Setting” option to “SRAM” or “OTP”. In this case, by 



clicking the “Download” button, the target firmware will be downloaded into the 



target board’s “SRAM” or “OTP” space correspondingly.  



For the TLSR8258, the starting SRAM address for target firmware is 0x040000. For 



other Telink’s SoCs, the starting SRAM address for target firmware is 0x008000. Of 



course, user can set other address as needed in the editable box.   



After the target file is downloaded successfully, the target board will not 



automatically run the new FW in “manual mode”, so user needs to click the “Reset” 



button to make program boot. User can also select “auto mode” via the drop-down 



menu before downloading, so as to enable auto MCU reset. 



 



Figure 18 Download firmware to “SRAM” via “auto mode”  



 If target board supports OTP function, user can download firmware into “OTP”. 



Refer to section 4 Function Support List for details. 
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2.1.5 Multi-address Download 



Sometimes, it is necessary to download more than one firmware into different 



addresses of FLASH, SRAM or OTP.  



For example, user can follow the steps below to download “Telink.bin” into the 



address “0x000000” and “0x005000” of FlASH. 



Step 1: Select the destination memory space (e.g. FLASH) to store firmware to be 



downloaded.



  



Figure 19 Select destination space 
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Step 2: Click “Tool->Multi-address download” or press the shortcut key “Ctrl + P”, so 



as to open the “Multi-address Download” interface. 



 



Figure 20 Open “Multi-address Download” interface 
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Step 3: Click the “Add” button so as to add firmware file and set target address. 



 



 



Step 4: Add the path of firmware 1 to the list and set the offset of starting address to 



store this firmware. 



1) First, select the first line (No.1), and click the “File” button to add target bin file 



(e.g. “Telink.bin”) to the list. The corresponding directory will be shown in the 



“File Path” column. 



 



 



Figure 21 Add FW 
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2) Then set the offset of starting FLASH address to store this firmware in the “Start 



Address(H)” column.  



To ensure that the destination area for firmware storage is valid, the tool will 



automatically calculate the firmware size and end address, and then show the 



calculation result in the “File Size(Bytes)” and “End Address(H)” column. 



 



 



Figure 22 Set offset address 



 



Step 5: Refer to step 4 to add the path of firmware 2 to the list and set the offset of 



starting address to store this firmware. 
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Step 6: Click the “Download” button to download the added firmware1 and 



firmware2 into the specific memory locations of the target board. 



 



 



 



 



Figure 23 Start downloading 



Step 7: After downloading all firmware into the target board, click the “Reset” button 



to make program run without the need to power cycle the target board.  



 



Figure 24 Reset 
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2.2 Flash sector erase  



    The “Flash sector erase” function is used to erase specific flash space starting 



from specific address in unit of 4kB. 



For example, to erase 64kB flash space starting from address 0x040000, user can 



follow the steps below. 



Step1: Click the “Setting” button to open the Setting dialog. Select the “FLASH” setting 



option. 



To set the starting address of flash space to be erased, e.g. 0x040000 (default 



option: 0x000000), user can either select the offset option (if available) via the drop-



down menu of “Erase Flash Addr” or directly input the offset address in the editable 



box.   



  



Figure 25 Select starting address 
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Step2: To set the size of flash space to be erased in unit of 4kB, e.g. 64kB (default 



option: 512kB), user can either select the size option (if available) via the drop-down 



menu of “Sector Erase Size” or directly input the size in the editable box. 



 



Figure 26 Set erase size 
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Step3: Click the “Erase” button to start erasing the specified flash space of the target 



board. 



 



Figure 27 Erase 512kB flash space starting from 0x000000 
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2.3 Activate MCU 



The function of “Activate MCU when communication with target board failed” 



only applies to Swire connection between “Burning EVK” and target board in “EVK” 



mode, i.e. it does NOT support “USB” mode or USB connection between “Burning EVK” 



and target board in “EVK” mode.  



When firmware burning fails, please ensure the target board is connected with 



“Burning EVK” via Swire, and then click the “Activate” button to enable this function 



to activate the MCU. 



 



Figure 28 Activate MCU 
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2.4 Debug 



After MCU starts running, to access memory space (flash/core/analog/otp), user 



can open the “Memory Access” window as shown in Figure 29 by directly pressing the 



shortcut key combination “Ctrl + M”, or by clicking “Tool->Memory Access”.  



 



Figure 29 “Memory Access” interface 



 



Table 1 Item list of Memory Access 



ITEMS Value list Default Shortcut 



MCU Type 8366/8368/8266/8267/8269/8232/8233/8x5x 8258 Ctrl+Q 



Communication 



Mode 
EVK(Burning EVK)/USB EVK Ctrl+W 



Operation 



Destination 
FLASH/CORE1/ANALOG2/OTP CORE Ctrl+E 



Operation Size 



(Unit: Byte) 
1/2/4/8/16 1 Ctrl+R 



Address 0 0 Ctrl+A 



Data 0 0 Ctrl+D 



                                                      



1 CORE includes digital registers and SRAM. 
2 ANALOG means analog registers. 
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2.4.1 Access memory 



2.4.1.1 Read data from memory space 



To read data from specific memory space (FLASH/CORE/ANALOG/OTP), user can 



follow the steps below: 



Step1: Select MCU type (e.g. “8258”) and communication mode (e.g. “EVK”) with 



target board on the “Memory Access” window. 



*Note: If you select “USB” mode to communicate with target board, please ensure that 



the selected MCU supports USB function and its USB function is available. 



 



Figure 30 Select MCU type and communication mode 
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Step2: Select operation destination (e.g. “CORE”) and set operation size (e.g. “16”) on 



the “Memory Access” window. 



*Notes:  



 If you select “OTP” as operation destination, please ensure that the selected MCU 



supports “OTP” function.  



 To set operation size, user can either select the size option (if available) via the 



drop-down menu, or directly set the size in the editable box. 



 The maximum operation size is 1MB. 



 



 



Figure 31 Set operation destination and size 



 



  



Te
li
nk
 f
or
 c
us
to
me
r











                  Telink Burning and Debugging Tool (BDT) User Guide 



AN-18101200-E1           39 Ver 1.0.0 



Step3: Move mouse cursor to the “addr” box, and then input the offset of the starting 



address to be read (e.g. “0x040000”). Keep the cursor in the “addr” box, by clicking 



the “Tab” key, user can read data from the specified memory space. 



*Notes:  



1) Every time when clicking the “Tab” key to initiate a memory reading operation, 



the value of editable box will be saved, so that you can directly select it via the 



drop-down menu next time. 



 



Figure 32 Set starting address and initiate reading  
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2) When reading memory space (e.g. CORE) larger than 1kB, the read data will be 



automatically saved to a file named “Read.bin” under the “user” folder.  



User can also use specific command line to change the name of file to save the 



read data. Refer to section 2.6 Command line for details.  



 



Figure 33 Save read data 
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2.4.1.2 Write data into memory space 



 To write data into specific memory space, user can follow the steps below: 



Step1: Select MCU type (e.g. “8258”) and communication mode (e.g. “EVK”) with 



target board on the “Memory Access” window. 



*Note: If you select “USB” mode to communicate with target board, please ensure that 



the selected MCU supports USB function and its USB function is available. 
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Step2: Select operation destination (e.g. “CORE”) and set operation size (e.g. “16”) on 



the “Memory Access” window. 



*Notes:  



 If you select “OTP” as operation destination, please ensure that the selected MCU 



supports “OTP” function.  



 To set operation size, user can either select the size option (if available) via the 



drop-down menu, or directly set the size in the editable box. 



 The maximum operation size is 256 bytes. 
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Step3: Move mouse cursor to the “addr” box, and then input the offset of the starting 



address to be written (e.g. “0x040000”). 



 



 



*Note: When operation destination is selected as “CORE”, if the address you set is less 



than the starting address of “SRAM”, the destination memory space that is actually 



accessed is digital register; if the address you set is greater than the starting address 



of “SRAM”, the destination memory space that is actually accessed is SRAM.  
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Step4: Write data to the specified address. 



Move mouse cursor to the “data” box, and then input the target data to be written. 



Keep the cursor in the “data” box, by clicking the “Enter” key, user can write the 



specified data into the specified memory space. 



*Note: When inputting the data, bytes must be separated from each other with space, 



as shown below: 



 



Figure 34 Set data and initiate writing 
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2.4.2 Operate Variable List 



Before viewing all global variables, please ensure that the “.lst” file and the “.bin” 



file are placed under the same directory as shown in the following two supported cases. 



Case 1: If only one pair of “.lst” file and the “.bin” file are placed under the same 



directory, this “.lst” file will be selected automatically.  



 



Case 2: if multiple“.lst” files and the “.bin” file are placed under the same directory, 



the “.lst” file with the name same as the selected “.bin” file will be selected 



automatically. 



 



For example, if you select the “Telink.bin” file, the “Telink.lst” file will be selected 



automatically. If there is no “Telink.lst” and only one “xxx.lst” file is placed under the 



directory containing the selected “Telink.bin” file, this sole “xxx.lst” file will be selected.  
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2.4.2.1 Update variable list 



To look through all global variables, user can select the “Tdebug” page, move 



mouse cursor to variable list, and then right click the mouse to choose “Refresh” or 



press the shortcut key “F3”. Each time by pressing “F3” anytime, variable list can be 



updated once. 



 



Figure 35 Update variable list 
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2.4.2.2 Sort variables 



As needed, user can also right click mouse, and choose the “Sort by address” to 



sort all variables by address from low to high (default), or choose the “Sort by name” 



to sort all variables by ASCII code value of variable name from A to z (compare the first 



different character). 



 



Figure 36 Sort variable by name 
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2.4.2.3 View variable above 4 bytes 



If a variable’s length is larger than 4 bytes, by clicking the “…” in the “Value” 



column of the “variable list”, its value will be available on the right log window.  



If a variable’s length is greater than 1024 bytes, all values of the variable will be 



saved in a file named “Read.bin”. 



 



Figure 37 Read variable value more than 4 bytes 
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2.4.2.4 Modify variable value 



The variable with the length no more than 4 bytes supports direct write operation, 



which means that its value can be directly modified by double clicking the 



corresponding box in the “Value” column.  



For example, to modify the value of the variable “rf_tp_base” in the address 



“0x41814” to “0x00000024”, user can follow the steps below:  



Step 1: Double click the box in the “Value” column corresponding to the specified 



variable (e.g. “rf_tp_base”), so as to make the box become editable.  



 



 



Figure 38 Double click specified “Value” box 
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Step 2: Input new variable value (e.g. “0x00000024”) to replace the old value 



(“0x00000025”).  



 



Figure 39 Modify variable value 
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Step3: Press the “Enter” key to write the new value into the specified variable’s 



address.  



 
Figure 40 Write data to specified address 



  



Te
li
nk
 f
or
 c
us
to
me
r











                  Telink Burning and Debugging Tool (BDT) User Guide 



AN-18101200-E1           52 Ver 1.0.0 



2.4.3 Debug MCU 



Before using the buttons including “Run”, “Pause”, “Step” and “PC” to debug MCU, 



please ensure that the selected MCU supports this function. Refer to section 4 



Function Support List for details.  



In the sub-sections below, the MCU “8258” is taken as an example to introduce 



this function. 



 



2.4.3.1 Run MCU 



After clicking the “Pause” or “Step” button, user can make MCU continue to run 



from the current position by clicking the “Run” button. Please check the status of MCU 



by clicking the “PC” button to read PC and ensure program is running again. 



 



Figure 41 Run MCU 
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2.4.3.2 Pause MCU 



 To view the status of MCU for details, user can click the “Pause” button to stall 



MCU. Click the “Run” button, MCU will continue to run from the current position.  



 



Figure 42 Pause MCU 
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2.4.3.3 Step MCU 



If the communication with target board is available, user can click the “Step” 



button to view the current position of instruction step by step.  



Both “Trace MCU” and “Step MCU” support two modes, as shown below.  



1) If the “Single step” mode is selected, MCU will enter single step mode, in which 



one PC tracing will be implemented after clicking the “PC” or “Step” button.  



2) If the “continuous” mode is selected, MCU will enter continuous mode and 



implement continuous PC tracing or make MCU step continuously.   



 



To cancel “continuous” mode, user can either switch mode to “Single step” mode, 



or click the “Run”/“Pause” button.  



 



Figure 43 Step MCU in “Single step” mode 
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Figure 44 Step MCU in “continuous” mode 



If the target firmware (bin file) and “xxx.lst” file are under the same directory, user 



can view more details by selecting “View->interp .lst” and clicking the “PC” button to 



analyze the “xxx.lst” file, as shown below. Refer to section 2.4.2 Operate Variable List.  



 



 
Figure 45 Select “interp .lst” 
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Figure 46 Step MCU with “interp .lst” selected in “Single step” mode  



 



  



Figure 47 Step MCU with “interp .lst” selected in “continuous” mode 
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2.4.3.4 Trace PC 



If the communication with target board is available, user can click the “PC” button 



to view the current position of instruction, as shown below: 



 



Figure 48 Trace PC in “Single step” mode 



 
Figure 49 Trace PC with “interp .lst” selected in “Single step” mode 
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Figure 50 Switch “Single step” mode to “continuous” mode 



 



Figure 51 Trace PC with “interp .lst” selected in “continuous” mode 
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2.4.3.5 Stall MCU 



When there is no enough time to view the status of MCU, user can click the “stall” 



button to stall MCU and view the status of MCU or change the configuration of MCU. 



Figure 52 Stall MCU 



 



*Note: In EVK mode, only the EVK burned with the “8266_JIG_EVK_v5.2.2.bin” (or 



higher version) supports this function.  
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2.4.3.6 Start MCU 



  After stalling MCU, click the “start” button to start MCU, so that MCU will run 



from the beginning of SRAM. 



 



Figure 53 Start MCU 
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2.5 Single-wire synchronization 



Before setting Single wire synchronization speed, please ensure the following 



items: 



1) Power supply is normal; 



2) MCU IS NOT in “Low Power” mode; 



3) Single wire function of MCU is available; 



4) System clock is normal. 



 



When connection fails to be established between “Burning EVK” and the target 



board, user can try to set Swire (single wire) synchronization speed to improve 



communication. *Note: Swire register address may vary with different chip types. 



1) Change the speed of Master and the speed of Slave in the four editable boxes, 



as shown below. Note that Swire register address may vary with chip types. 



2) Click the “SWS” button to implement Swire synchronization. 



 



Figure 54 Set Swire synchronization speed 



  



  



Te
li
nk
 f
or
 c
us
to
me
r











                  Telink Burning and Debugging Tool (BDT) User Guide 



AN-18101200-E1           62 Ver 1.0.0 



Before downloading firmware to target board or debugging MCU, it is suggested 



that every time on MCU power on, user should implement one Swire synchronization 



to check whether communication with target board is OK.  



 If the status of communication with target board is wrong, user can solve the 



problem according to the methods mentioned at the beginning of section 2.5. 
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2.6 Command line 



User can also use command line to access memory or download file into target 



board. In the sub-sections below, “read core” is taken as an example. 



 



2.6.1 Single command line 



Step 1: Open command line input window by selecting the “Tool->Cmdline Input” or 



pressing the shortcut key combination “Ctrl + I”.  



 



 
Figure 55 Open cmdline input window 
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Step 2:  Input the needed single command as follows and then press the “Enter” key. 



The file with the specified named will be available in the specified location.  



 



Figure 56 Enter single command line 
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2.6.2 Multi-command line 



The tool supports multi-command line operation.  



All commands need to be separated from each other by semicolon, as shown 



below. 



 



 



Figure 57 Enter multiple commands  
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2.7 Log windows 



This tool supports USB print function, so MCUs with USB function can use USB 



print function to output information in log windows on PC side. 



Step 1: Click the “View->usb log” to open usb log windows. 



 



 



Figure 58 Open usb log windows 



  



Te
li
nk
 f
or
 c
us
to
me
r











                  Telink Burning and Debugging Tool (BDT) User Guide 



AN-18101200-E1           67 Ver 1.0.0 



Step 2: In the “usb log” mode, all output characters will be displayed in “Ascii” mode; 



 



Figure 59 Display output characters 



Step 3: Click the “View->usb log” again to exit the “usb log” mode. 



 



Figure 60 Exit usb log mode 
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2.8 Help 



By clicking the “Help->Command line”, all commands will be shown in log 



windows of the “Download” or “Tdebug” page.  



 



 



 



Figure 61 Show all commands 
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By clicking the “Help->User guide”, the embedded “Help” document “Telink 



Burning and Debugging Tool (BDT) User Guide” will be opened, as shown below. 



 



 



 



Figure 62 Open Help document 
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To get more information about Telink, user can click the “Help->About Telink”. 



 



 
 



 



Figure 63 Get information about Telink 
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2.9 Default configuration 



Open the folder “config” in the root directory of this tool as follows. 



 



All default configurations in this tool can be changed by modifying the “config.ini” 



file. Following shows detailed explanations. 



 



 ① MCU Type:8368 



 ② The path of the firmware: \bin\dut_8368_flash_v0246.bin 



 This firmware is used to operate flash, e.g. download the specified firmware into 



flash, read/write flash, erase sectors of flash and check flash data when downloading 



firmware to flash or erase some sector of flash 



 ③ SRAM Starting Address: 0x8000, e.g.8258:0x40000; 



 ④ Single wire communication: 



1) Swire register base address of master device:0xb0 



2) Swire clock of master device:0x10 



3) Swire register base address of slave device:0xb0 



4) Swire clock of slave device:0x10 



 ⑤ The path of the firmware:  



Firmware1: \bin\dut_8368_otp_v0005.bin, which is used to operate OTP, e.g. 



download firmware to OTP, read/write OTP, check OTP data during writing data to 



OTP or downloading firmware to OTP or write data to OTP 



 Firmware2: \bin\dut_8368_otp_normal_v0002.bin,which is used to check OTP 



data during downloading firmware to OTP or write date to OTP 



 ⑥ default: 8258 



 
① Mode of Communication: USB 



 ② default: EVK(Burning EVK) 



 
① Access Objection: FLASH 



 ② default: CORE 



1 2 3 4 5 
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① Size of Read / Write data: 2 



 ② default: 1 



 



① Download address: 0x20000 



 ② default: 0 



 



① Erase address: 0x20000 



 ② default: 0 



 



① Page Display: 1 - Tdebug 



 ② default: 0 - Download 



 



① The Name of Button1: example1 



 ② The property of Button1: external executable application 



 ③ The Path of external executable application: E:\1_wtcdb\tcdb.exe uart -1 –u 



④ undefined Button: Button4 



 The property of Button includes three types: 



1) external_exe: external executable application 



2) internal_exe: internal executable application, which means this tool. 



3) external_file: open any external file by default 



 



① The Path of firmware: “C:\Users\Administrator\Desktop\Telink.bin” 



Download this firmware into target board to update firmware. When there’re too 



many file paths, you can directly delete these. However, the first path can’t be deleted. 



 ② default file path: “C:\Users\Administrator\Desktop\Telink.bin” 
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3 Upgrade Firmware 



User can follow the steps below to upgrade firmware of “Burning EVK”. 



Step 1: Click “Help->Upgrade” to open the dialog window “Upgrade EVK”. 



 



Figure 64 “Upgrade EVK” window 



Step 2: Click the button “Read FW Version” to check the current firmware version. 



 



Figure 65 Check current FW version 
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Step 3: Click the “Load…” button to load the new firmware. 



 



Figure 66 Load new FW 



Step 4: Click the “Upgrade” button to upgrade the new firmware into the “Burning 



EVK”. Note: User MUST power cycle the EVK before using it. 



  



Figure 67 Upgrade FW into EVK 
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4 Function Support List 



Not all MCU types support all functions of this tool. Please refer to the table below. 
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1 Brief Introduction 



Telink “Cmd_download_tool” applies to all engineers who want to develop 



applications based on Telink SoCs including 8267, 8266, 8232, 8233, 8366, 8368 and 



8258.  



This document presents the guide on how to use “Cmd_download_tool” by 



command line. 



 



1.1 Function Overview  



During SDK development, by using “Cmd_download_tool”, firmware can be 



directly downloaded into the target board (e.g. development board) via USB mode or 



“Burning EVK” (abbreviated as EVK) mode.           



Its main functions include “Erase flash sector”, “Download firmware”, “Activate 



MCU when communication failed”, “Access memory space including FLASH /CORE 



/ANALOG /OTP”, “Read/Write variable” and “View USB log”. 



 



 
Figure 1 Cmd_download_tool interface 



Te
li
nk
 f
or
 c
us
to
me
r











  Telink Cmd_download_tool User Guide 



AN-18101500-E1           6 Ver 1.0.0 



2 Operation Guide 



2.1 Download firmware 



2.1.1 Connect hardware 



Before using “Cmd_download_tool”, it’s needed to connect the target board with 



PC.  



There are two methods to connect the target board with PC, as shown below. 



Method 1: Directly connect the target board with PC via USB method.  



This method only applies to target board with USB interface and MCU supporting 



USB function, e.g. a dongle board. 



 



Figure 2 Directly connect target board with PC 



 



Method 2: Connect the target board with PC via Telink “Burning EVK” 



TLSR8266BR56. 



1) Connect the “Burning EVK” with PC via an USB cable. Observe the indicating 



lights of the “Burning EVK”: The indicating lights will blink once to indicate that 



the “Burning EVK” and its connection with PC is OK. Te
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Figure 3 Connect “Burning EVK” with PC 



 



2) Connect target board with “Burning EVK”. 



There are two methods to connect the target board with the “Burning EVK”. 



a) Connect the target board with the “Burning EVK” via USB interface directly, 



as shown below. This connection method only applies to target board with 



USB interface and MCU supporting USB function, e.g. a dongle board. 



 



Figure 4 Connect target board with “Burning EVK” via USB 



LED 



Burning EVK 
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b) Connect the target board with the “Burning EVK” via Swire (Single wire) 



interface, as shown below.  



 



Figure 5 Connect target board with “Burning EVK” via Swire  



 



Please refer to Telink document “AN_18010500_User Guide for Telink Burning 



EVK TLSR8266BR56” for the detailed guide of TLSR8266BR56. 



 



After connecting the target board to PC via USB method or “Burning EVK” 



method, there are two methods to download firmware into the target board, which 



respectively correspond to the two hardware connection methods above.  
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2.1.2 Download FW into “FLASH” via “USB” mode  



Before using “USB” mode to download or debug MCU, please ensure that the 



specified MCU supports USB function and its USB function is available. Refer to section 



3 Function Support List for details. To download firmware into specific flash space of 



the target board via “USB” mode, user can enter the corresponding command.   



Command line example: 



./Cmd_download_tool.exe 8258 wf 0 –i C:\Users\Administrator\Desktop\Telink.bin -u 



Parameters: 



 Para1: MCU Type – 8258 



 Para2: operation command (see 2.8 Command list) – “wf” (write flash) 



 Para3: the starting address to store target firmware to be downloaded – “0” 



 Para4: optional command – “-i” (along with the path of firmware)  



 Para5: the path of firmware – “C:\Users\Administrator\Desktop\Telink.bin”   



 Para6: optional command – “-u”(Communication mode with target board: “USB” 



mode) 



 



Figure 6 Download FW in “USB” mode 
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 After downloading firmware into the target board, user can enter the 



corresponding command line, so as to directly “reset” MCU without the need to power 



cycle the target board. 



Command line example: 



./Cmd_download_tool.exe 8258 rst –u –f 



Parameters: 



 Para1: MCU Type – 8258 



 Para2: operation command (see 2.8 Command list) – “rst” (reset) 



 Para3: optional command – “-u”(Communication mode with target board: “USB” 



mode) 



 Para4: optional command – “-f” (Flash, “-c”: CORE)  



If downloading firmware to Flash, “-f” should be selected herein to reset MCU. 



If downloading firmware to SRAM, “-c” should be selected instead to reset MCU. 



 



Figure 7 Reset MCU 
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2.1.3 Download FW into “FLASH” via “EVK” mode 



Before using “EVK” mode to download firmware, please ensure that target board 



is connected to PC via “Burning EVK” method and the single wire communication of 



target board is available. To download firmware into specific flash space of the target 



board via “Burning EVK” mode, user can enter the corresponding command line.  



Command line example: 



./Cmd_download_tool.exe 8258 wf 0 –i C:\Users\Administrator\Desktop\Telink.bin 



Parameters: 



 Para1: MCU Type – 8258 



 Para2: operation command (see 2.8 Command list) – “wf” (write flash) 



 Para3: the starting address to store target firmware to be downloaded – “0” 



 Para4: optional command – “-i” (along with the path of firmware)  



 Para5: the path of firmware – “C:\Users\Administrator\Desktop\Telink.bin”   



Since the command line does not contain the optional command “-u”, “EVK” 



communication mode with the target board is selected. 



 
Figure 8 Download FW in “EVK” mode 
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After downloading firmware into target board, user can enter the corresponding 



command line, so as to directly “reset” MCU without the need to power cycle the 



target board.  



Command line example: 



./Cmd_download_tool.exe 8258 rst –f 



Parameters: 



 Para1: MCU Type – 8258 



 Para2: operation command (see 2.8 Command list) – “rst” (reset) 



 Para3: optional command – “-f” (Flash, “-c”: CORE)  



If downloading firmware to Flash, “-f” should be selected herein to reset MCU. 



If downloading firmware to SRAM, “-c” should be selected instead to reset MCU. 
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2.1.4 Download FW into “SRAM” or “OTP” 



User can download firmware to “SRAM”/“OTP” instead of Flash. To download FW 



into specific “SRAM” or “OTP” space of the target board via “USB” mode, user can 



enter the corresponding command line. Before using this method to download FW, 



user should know the starting address of “SRAM” for specific MCU. e.g. 8258: 0x40000.  



Command line example to download FW into SRAM: 



./Cmd_download_tool.exe 8258 wc 40000 –i C:\Users\Administrator\Desktop\Telink. 



bin 



Parameters: 



 Para1: MCU Type – 8258 



 Para2: operation command (see 2.8 Command list) – “wc” (write CORE including 



digital register and SRAM) 



 Para3: the starting address to store target firmware to be downloaded – “40000” 



 Para4: optional command – “-i” (along with the path of firmware)  



 Para5: the path of firmware – “C:\Users\Administrator\Desktop\Telink.bin”   



Since the command line does not contain the optional command “-u”, “EVK” 



communication mode with the target board is selected. 



 



 



Figure 9 Download FW into “SRAM” via “EVK” mode  
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Command line to download FW into OTP (if target board supports OTP): 



./Cmd_download_tool.exe 8368 wo 0 –i C:\Users\Administrator\Desktop\Telink.bin 



Parameters: 



 Para1: MCU Type – 8368 



 Para2: operation command (see 2.8 Command list) – “wo” (write OTP) 



 Para3: the starting address to store target firmware to be downloaded – “0” 



 Para4: optional command – “-i” (along with the path of firmware)  



 Para5: the path of firmware – “C:\Users\Administrator\Desktop\Telink.bin” 



Since the command line does not contain the optional command “-u”, “EVK” 



communication mode with the target board is selected. 
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2.2 Reset MCU 



After downloading firmware to target board, user can reset MCU to make the 



newly-downloaded program run without the need to power cycle the target board. 



Command line to reset MCU: 



./Cmd_download_tool.exe 8258 rst -f 



Parameters: 



 Para1: MCU Type – 8258 



 Para2: operation command (see 2.8 Command list) – “rst”  



 Para3: optional command – “-f” 



After downloading firmware to the flash or OTP of target board, user should use 



the optional command “-f” to reset MCU. 



After downloading firmware to the SRAM of target board, user should use the 



optional command “-c” instead to reset MCU. 



Since the command line does not contain the optional command “-u”, “EVK” 



communication mode with the target board is selected. 
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2.3 Flash sector erase  



    The “Flash sector erase” function is used to erase specific flash space starting 



from specific address in the unit of sector (4kB). 



For example, to erase 64kB flash space of TLSR8258 starting from address 



0x004000, user can enter the command line below. 



Command line example: 



./Cmd_download_tool.exe 8258 wf 4000 –s 64k –e 



Parameters: 



 Para1: MCU Type – 8258 



 Para2: operation command (see 2.8 Command list) – “wf” (write flash) 



 Para3: the starting address of space to be erased – “4000”  



 Para4: optional command – “-s” (along with the size of sectors to be erased)  



 Para5: the size of sectors to be erased – “64k”  



 Para6: optional command – “-e” (erase flash) 



Since the command line does not contain the optional command “-u”, “EVK” 



communication mode with the target board is selected. 



 
Figure 10 Erase flash space via “EVK” mode 
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2.4 Activate MCU 



The function of “Activate MCU when communication with target board failed” 



only applies to Swire connection between “Burning EVK” and target board in “EVK” 



mode, i.e. it does not support “USB” mode or USB connection between “Burning EVK” 



and target board in “EVK” mode.  



When firmware burning fails, please ensure the target board is connected with 



“Burning EVK” via Swire. User can enter the corresponding command line to enable 



this function to activate the MCU. 



Command line example: 



./Cmd_download_tool.exe 8258 ac 



Parameters: 



 Para1: MCU Type – 8258 



 Para2: operation command (see 2.8 Command list) – “ac” (Activate MCU) 



 



Figure 11 Activate MCU 
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2.5 Debug 



After MCU starts running, user can access memory space 



(FLASH/CORE/ANALOG/OTP) by using this tool. 



 



2.5.1 Read data 



To read data from specific memory space (FLASH/CORE/ANALOG/OTP), user can 



enter the corresponding command line. 



Command line examples: 



 Read flash: ./Cmd_download_tool.exe 8258 rf 0 –s 16 



 Read core(digital register/SRAM): ./Cmd_download_tool.exe 8258 rc 0 –s 16 



 Read analog register : ./Cmd_download_tool.exe 8258 ra 0 –s 16 



 Read OTP: ./Cmd_download_tool.exe 8258 ro 0 –s 16 



Note that the maximum operation size is 1MB. Refer to 2.8 Command list for 



details. 



When reading memory space larger than 1024 bytes, the data will be saved to a 



file with default name of “/user/read.bin”. The command line below can be used to 



customize the file name. 



Command line example: ./Cmd_download_tool.exe 8258 rc 40000 –s 8k –o 



C:\Users\Administrator\Desktop\Telink_read.bin -u 
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2.5.2 Write data 



 To write data into specific memory space, user can enter the corresponding 



command line. 



Command line examples: 



 write flash: ./Cmd_download_tool.exe 8258 wf 0 11 22 33 44 –s 4 



 write core(digital register/sram): ./Cmd_download_tool.exe 8258 wc 40000  11 



22 33 44 –s 4 



 write analog register : ./Cmd_download_tool.exe 8258 wa 34 11 22 33 44 –s 4 



 write otp: ./Cmd_download_tool.exe 8258 wo 0 11 22 33 44 –s 4 



Note that the maximum operation size is 256 bytes. Refer to 2.8 Command list 



for details. 



 
 



2.5.3 Trace PC 



User can enter the corresponding command line to read “PC”.  



Command line example: ./Cmd_download_tool.exe 8258 pc -u 



 



To get more details, you need to offer “.lst” file that can match with firmware. 



Command line example: 



./Cmd_download_tool.exe 8258 pc –i C:\Users\Administrator\Desktop\Telink.lst –u 
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2.6 Single-wire synchronization 



Before setting Single wire synchronization speed, please ensure the following 



items:  



1) Power supply is normal; 



2) MCU IS NOT in “Low Power” mode; 



3) Single wire function of MCU is available; 



4) System clock is normal. 



 



When connection fails to be established between “Burning EVK” and the target 



board, user can try to set Swire (single wire) synchronization speed to improve 



communication by entering the corresponding command line. *Note: Swire register 



address may vary with different chip types.  



Command line example: 



./Cmd_download_tool.exe 8258 sws b0 10 b0 10 



 Swire command: sws 



 base address of Master device: 0xb0 



 the speed of Master device: 0x10 



 base address of Slave device: 0xb0 



 the speed of Slave device: 0x10 



 



Figure 12 Set Swire synchronization speed 



 



 Before downloading firmware to target board or debugging MCU, It is suggested 



that every time on MCU power on, user should implement one Swire synchronization 



to check whether communication with target board is OK.  



 If the status of communication with target board is wrong, user can solve the 



problem according to the methods mentioned at the beginning. 
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2.7 Log windows 



This tool supports USB print function, so MCUs with USB function can use USB 



print function to output information in log windows on PC side. 



Command line example: ./Cmd_download_tool.exe 8258 log usb 1 –u 



 



Figure 13 usb log windows 



Press “Esc” to exit the log windows. 



2.8 Command list 



A list will be available to show all supported command lines by entering the 



command line below. 



Command line to show command list: ./Cmd_download_tool.exe help 



 



Figure 14 Command line - help 
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2.9 Default configuration 



Open the folder “config” in the root directory of this tool as follows. 



 



All default configurations in this tool can be changed by modifying the “config.ini” 



file. Following shows detailed explanations. 



 



 ① MCU Type:8368 



 ② The path of the firmware: \bin\dut_8368_flash_v0246.bin 



 This firmware is used to operate flash, e.g. download the specified firmware into 



flash, read/write flash, erase sectors of flash and check flash data when downloading 



firmware to flash or erase some sector of flash 



 ③ SRAM Starting Address: 0x8000, e.g.8258:0x40000; 



 ④ Single wire communication: 



1) Swire register base address of master device:0xb0 



2) Swire clock of master device:0x10 



3) Swire register base address of slave device:0xb0 



4) Swire clock of slave device:0x10 



 ⑤ The path of the firmware:  



Firmware1: \bin\dut_8368_otp_v0005.bin, which is used to operate OTP, e.g. 



download firmware to OTP, read/write OTP, check OTP data during writing data to 



OTP or downloading firmware to OTP or write data to OTP 



 Firmware2: \bin\dut_8368_otp_normal_v0002.bin,which is used to check OTP 



data during downloading firmware to OTP or write date to OTP 



 ⑥ default: 8258 



 
① Mode of Communication: USB 



 ② default: EVK(Burning EVK) 



 



① Access Objection: FLASH 



 ② default: CORE 



1 2 3 4 5 
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① Size of Read / Write data: 2 



 ② default: 1 



 



① Download address: 0x20000 



 ② default: 0 



 



① Erase address: 0x20000 



 ② default: 0 



 



① Page Display: 1 - Tdebug 



 ② default: 0 - Download 



 



① The Name of Button1: example1 



 ② The property of Button1: external executable application 



 ③ The Path of external executable application: E:\1_wtcdb\tcdb.exe uart -1 –u 



④ undefined Button: Button4 



 The property of Button include three types: 



1) external_exe: external executable application 



2) internal_exe: internal executable application, which means this tool. 



3) external_file: open any external file by default 



 



① The Path of firmware: “C:\Users\Administrator\Desktop\Telink.bin” 



Download this firmware to target board to update firmware. When there’re too 



many file paths, you can directly delete these. However, the first path can’t be deleted. 



 ② default file path: “C:\Users\Administrator\Desktop\Telink.bin” 
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3 Function Support List 



Not all MCU types support all functions of this tool. Please refer to the table below. 
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Legal Disclaimer 
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under its patent rights, nor the rights of others 
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and agree to fully indemnify Telink Semiconductor for any damages arising or 
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Information: 



For further information on the technology, product and business term, please 
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telinkcnsupport@telink-semi.com  
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1 Brief Introduction 



This document presents guide on how to use Telink TLSR8266-based burning 



EVK “TLSR8266BR56” as an adapter to download firmware into target board (DUT).   



 



Top view 



    



   Left side view                     Right side view 



Figure 1 TLSR8266BR56 photo  
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2 Connection Guide 



2.1 Supply power for TLSR8266BR56 



Connect the miniUSB interface of the TLSR8266BR56 with PC USB via a mini USB 



cable. 



  



Figure 2 Connection chart to supply power for TLSR8266BR56  
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2.2 Download firmware into DUT via TLSR8266BR56  



The TLSR8266BR56 is used as burning adapter and it is preloaded with the 



“8266_evk.bin”.  



Method 1: Connect the TLSR8266BR56 with DUT via Single wire (Swire).  



1. Connect the miniUSB interface of the TLSR8266BR56 with PC USB via a mini USB 



cable.   



User can observe the indicating LED to check the TLSR8266BR56: If the light 



blinks once, it indicates the TLSR8266BR56 and its connection with PC are both 



OK.  



2. Connect the pin header of the TLSR8266BR56 with DUT via Swire: connect SWM, 



GND and 3V3 of pin header with SWS, GND and 3.3V of DUT, respectively.  



    



Figure 3 Connection chart 1 to download FW into DUT via TLSR8266BR56 
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Method 2: Connect the TLSR8266BR56 with DUT via USB instead of Swire. This 



method only applies to the DUT with USB interface (e.g. dongle board). 



1. Connect the miniUSB interface of the TLSR8266BR56 with PC USB via a mini USB 



cable.  



2. Connect the USB interface of the TLSR8266BR56 with the USB interface of the 



DUT.  



    



Figure 4 Connection chart 2 to download FW into DUT via TLSR8266BR56 
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2.3 Communication interface 



    



Figure 5 TLSR8266BR56 communication interface 



Please refer to the schematic in section 3 for the connection guide of 



SPI/I2C/UART interface. 
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3 Schematic 



 
 



 



Figure 6 TLSR8266BR56 schematic 
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[ITEM2]

name 			 = "PA5"

gpio  			 = 586[5]  

ie			 	 = 581[5]  

oen			 	 = 582[5]  

output		 	 = 583[5]  

[ITEM3]

name 			 = "PA6"

gpio  			 = 586[6]  

ie			 	 = 581[6]  

oen			 	 = 582[6]  

output		 	 = 583[6]

[ITEM4]

name 			 = "PA7"

gpio  			 = 586[7]  

ie			 	 = 581[7]  

oen			 	 = 582[7]  

output		 	 = 583[7]  

[ITEM5]

name 			 = "PB0"

gpio  			 = 58e[0]  

ie			 	 = 589[0]  

oen			     = 58a[0]  

output		     = 58b[0] 

[ITEM6]

name 			 = "PB1"

gpio  			 = 58e[1]  

ie			 	 = 589[1]  

oen			     = 58a[1]  

output		     = 58b[1] 

[ITEM7]

name 			 = "PB4"

gpio  			 = 58e[4]  

ie			 	 = 589[4]  

oen			     = 58a[4]  

output		     = 58b[4] 

[ITEM8]

name 			 = "PB7"

gpio  			 = 58e[7]  

ie			 	 = 589[7]  

oen			     = 58a[7]  

output		     = 58b[7]  

[ITEM9]

name 			 = "PC0"

gpio             = 596[0]  

ie			 	 = 591[0]  

oen		  		 = 592[0]  

output		 	 = 593[0]

[ITEM10]

name 			 = "PC1"

gpio             = 596[1]  

ie			 	 = 591[1]  

oen		  		 = 592[1]  

output		 	 = 593[1] 

[ITEM11]

name 			 = "PC2"

gpio             = 596[2]  

ie			 	 = 591[2]  

oen		  		 = 592[2]  

output		 	 = 593[2]  

[ITEM12]

name 			 = "PC3"

gpio             = 596[3]  

ie			 	 = 591[3]  

oen		  		 = 592[3]  

output		 	 = 593[3]

[ITEM13]

name 			 = "PC4"

gpio             = 596[4]  

ie			 	 = 591[4]  

oen		  		 = 592[4]  

output		 	 = 593[4]  

[ITEM14]

name 			 = "PC5"

gpio             = 596[5]  

ie			 	 = 591[5]  

oen		  		 = 592[5]  

output		 	 = 593[5] 

[ITEM15]

name 			 = "PC6"

gpio             = 596[6]  

ie			 	 = 591[6]  

oen		  		 = 592[6]  

output		 	 = 593[6]

[ITEM16]

name 			 = "PC7"

gpio             = 596[7]  

ie			 	 = 591[7]  

oen		  		 = 592[7]  

output		 	 = 593[7] 

[ITEM17]

name 			 = "PD0"

gpio 			 = 59e[0]

ie			 	 = 599[0] 

oen     		 = 59a[0]

output      	 = 59b[0]

[ITEM18]

name 			 = "PD1"

gpio 			 = 59e[1]

ie			 	 = 599[1] 

oen     		 = 59a[1]

output      	 = 59b[1]

[ITEM19]

name 			 = "PD2"

gpio 			 = 59e[2]

ie			 	 = 599[2] 

oen     		 = 59a[2]

output      	 = 59b[2]

[ITEM20]

name 			 = "PD3"

gpio 			 = 59e[3]

ie			 	 = 599[3] 

oen     		 = 59a[3]

output      	 = 59b[3]

[ITEM21]

name 			 = "PD4"

gpio 			 = 59e[4]

ie			 	 = 599[4] 

oen     		 = 59a[4]

output      	 = 59b[4]

[ITEM22]

name 			 = "PD5"

gpio 			 = 59e[5]

ie			 	 = 599[5] 

oen     		 = 59a[5]

output      	 = 59b[5]

[ITEM23]

name 			 = "PD6"

gpio 			 = 59e[6]

ie			 	 = 599[6] 

oen     		 = 59a[6]

output      	 = 59b[6]

[ITEM24]

name 			 = "PD7"

gpio 			 = 59e[7]

ie			 	 = 599[7] 

oen     		 = 59a[7]

output      	 = 59b[7]

[ITEM25]

name 			 = "PE0"

gpio			 = 5a6[0]

ie			 	 = 5a1[0] 

oen    			 = 5a2[0]

output			 = 5a3[0]

[ITEM26]

name 			 = "PE1"

gpio			 = 5a6[1]

ie			 	 = 5a1[1] 

oen    			 = 5a2[1]

output			 = 5a3[1]

[ITEM27]

name 			 = "PE2"

gpio			 = 5a6[2]

ie			 	 = 5a1[2] 

oen    			 = 5a2[2]

output			 = 5a3[2]

[ITEM28]

name 			 = "PE3"

gpio			 = 5a6[3]

ie			 	 = 5a1[3] 

oen    			 = 5a2[3]

output			 = 5a3[3]

[ITEM29]

name 			 = "PE4"

gpio			 = 5a6[4]

ie			 	 = 5a1[4] 

oen    			 = 5a2[4]

output			 = 5a3[4]

[ITEM30]

name 			 = "PE5"

gpio			 = 5a6[5]

ie			 	 = 5a1[5] 

oen    			 = 5a2[5]

output			 = 5a3[5]










EMI_TOOL/config/.svn/text-base/8267_8261.ini.svn-base

[common]

GPIO_CNT = 33

gpio  			 = 1

ie			 	 = 1

oen			 	 = 0 

output		 	 = 1

[ITEM0]

name 			 = "PA0"

gpio  			 = 586[0]  

ie			 	 = 581[0]  

oen			 	 = 582[0]  

output		 	 = 583[0]  

[ITEM1]

name 			 = "PA1"

gpio  			 = 586[1]  

ie			 	 = 581[1]  

oen			 	 = 582[1]  

output		 	 = 583[1]  

[ITEM2]

name 			 = "PA2"

gpio  			 = 586[2]  

ie			 	 = 581[2]  

oen			 	 = 582[2]  

output		 	 = 583[2]  

[ITEM3]

name 			 = "PA3"

gpio  			 = 586[3]  

ie			 	 = 581[3]  

oen			 	 = 582[3]  

output		 	 = 583[3]  

[ITEM4]

name 			 = "PA4"

gpio  			 = 586[4]  

ie			 	 = 581[4]  

oen			 	 = 582[4]  

output		 	 = 583[4]  

[ITEM5]

name 			 = "PA5"

gpio  			 = 586[5]  

ie			 	 = 581[5]  

oen			 	 = 582[5]  

output		 	 = 583[5]  

[ITEM6]

name 			 = "PA6"

gpio  			 = 586[6]  

ie			 	 = 581[6]  

oen			 	 = 582[6]  

output		 	 = 583[6]  

[ITEM7]

name 			 = "PA7"

gpio  			 = 586[7]  

ie			 	 = 581[7]  

oen			 	 = 582[7]  

output		 	 = 583[7]  

[ITEM8]

name 			 = "PB1"

gpio  			 = 58e[1]  

ie			 	 = 589[1]  

oen			     = 58a[1]  

output		     = 58b[1]  

[ITEM9]

name 			 = "PB2"

gpio  			 = 58e[2]  

ie			 	 = 589[2]  

oen			     = 58a[2]  

output		     = 58b[2]  

[ITEM10]

name 			 = "PB3"

gpio  			 = 58e[3]  

ie			 	 = 589[3]  

oen			     = 58a[3]  

output		     = 58b[3]  

[ITEM11]

name 			 = "PB4"

gpio  			 = 58e[4]  

ie			 	 = 589[4]  

oen			     = 58a[4]  

output		     = 58b[4]  

[ITEM12]

name 			 = "PB5"

gpio  			 = 58e[5]  

ie			 	 = 589[5]  

oen			     = 58a[5]  

output		     = 58b[5]  

[ITEM13]

name 			 = "PB6"

gpio  			 = 58e[6]  

ie			 	 = 589[6]  

oen			     = 58a[6]  

output		     = 58b[6]  

[ITEM14]

name 			 = "PB7"

gpio  			 = 58e[7]  

ie			 	 = 589[7]  

oen			     = 58a[7]  

output		     = 58b[7]  

[ITEM15]

name 			 = "PC0"

gpio             = 596[0]  

ie			 	 = 591[0]  

oen		  		 = 592[0]  

output		 	 = 593[0]  

[ITEM16]

name 			 = "PC1"

gpio             = 596[1]  

ie			 	 = 591[1]  

oen		  		 = 592[1]  

output		 	 = 593[1]  

[ITEM17]

name 			 = "PC2"

gpio             = 596[2]  

ie			 	 = 591[2]  

oen		  		 = 592[2]  

output		 	 = 593[2]  

[ITEM18]

name 			 = "PC3"

gpio             = 596[3]  

ie			 	 = 591[3]  

oen		  		 = 592[3]  

output		 	 = 593[3]  

[ITEM19]

name 			 = "PC4"

gpio             = 596[4]  

ie			 	 = 591[4]  

oen		  		 = 592[4]  

output		 	 = 593[4]  

[ITEM20]

name 			 = "PC5"

gpio             = 596[5]  

ie			 	 = 591[5]  

oen		  		 = 592[5]  

output		 	 = 593[5]  

[ITEM21]

name 			 = "PC6"

gpio             = 596[6]  

ie			 	 = 591[6]  

oen		  		 = 592[6]  

output		 	 = 593[6]  

[ITEM22]

name 			 = "PC7"

gpio             = 596[7]  

ie			 	 = 591[7]  

oen		  		 = 592[7]  

output		 	 = 593[7] 

[ITEM23]

name 			 = "PD0"

gpio 			 = 59e[0]

ie			 	 = 599[0] 

oen     		 = 59a[0]

output      	 = 59b[0]

[ITEM24]

name 			 = "PD1"

gpio 			 = 59e[1]

ie			 	 = 599[1] 

oen     		 = 59a[1]

output      	 = 59b[1]

[ITEM25]

name 			 = "PD2"

gpio 			 = 59e[2]

ie			 	 = 599[2] 

oen     		 = 59a[2]

output      	 = 59b[2]

[ITEM26]

name 			 = "PD3"

gpio 			 = 59e[3]

ie			 	 = 599[3] 

oen     		 = 59a[3]

output      	 = 59b[3]

[ITEM27]

name 			 = "PD4"

gpio 			 = 59e[4]

ie			 	 = 599[4] 

oen     		 = 59a[4]

output      	 = 59b[4]

[ITEM28]

name 			 = "PD5"

gpio 			 = 59e[5]

ie			 	 = 599[5] 

oen     		 = 59a[5]

output      	 = 59b[5]

[ITEM29]

name 			 = "PD6"

gpio 			 = 59e[6]

ie			 	 = 599[6] 

oen     		 = 59a[6]

output      	 = 59b[6]

[ITEM30]

name 			 = "PD7"

gpio 			 = 59e[7]

ie			 	 = 599[7] 

oen     		 = 59a[7]

output      	 = 59b[7]

[ITEM31]

name 			 = "PE0"

gpio			 = 5a6[0]

ie			 	 = 5a1[0] 

oen    			 = 5a2[0]

output			 = 5a3[0]

[ITEM32]

name 			 = "PE1"

gpio			 = 5a6[1]

ie			 	 = 5a1[1] 

oen    			 = 5a2[1]

output			 = 5a3[1]






EMI_TOOL/config/8258.ini

[common]

;for  swire long address(3 bytes)

swire_laddr = 1 

;for  change power and rx_test will reset dut ,and then test 

bug_reset   = 0

[power_lever]

cnt = 50

name0 = 10.5dbm

name1 = 10.3dbm

name2 = 10.0dbm

name3 = 9.8dbm

name4 = 9.5dbm

name5 = 9.2dbm

name6 = 9.0dbm

name7 = 8.7dbm

name8 = 8.4dbm

name9 = 8.1dbm

name10 = 7.8dbm

name11 = 7.4dbm

name12 = 7.0dbm

name13 = 6.6dbm

name14 = 6.1dbm

name15 = 5.6dbm

name16 = 5.1dbm

name17 = 4.8dbm

name18 = 3.9dbm

name19 = 3.2dbm

name20 = 3.0dbm

name21 = 2.8dbm

name22 = 2.6dbm

name23 = 2.4dbm

name24 = 1.9dbm

name25 = 1.7dbm

name26 = 1.4dbm

name27 = 1.1dbm

name28 = 0.9dbm

name29 = 0.5dbm

name30 = 0.0dbm

name31 = -0.1dbm

name32 = -0.9dbm

name33 = -1.4dbm

name34 = -1.8dbm

name35 = -2.5dbm

name36 = -3.0dbm

name37 = -3.6dbm

name38 = -4.2dbm

name39 = -5.0dbm

name40 = -5.8dbm

name41 = -6.6dbm

name42 = -7.6dbm

name43 = -8.6dbm

name44 = -9.8dbm

name45 = -11.4dbm

name46 = -13.2dbm

name47 = -15.8dbm

name48 = -19.2dbm

name49 = -25.1dbm

[pm]

;是否支持PM测试

page_enable = 1

button0_enable = 1

button0_name = Deep

button1_enable = 1

button1_name = Suspend

button2_enable = 1

button2_name = Deep with retension 

wake_up_io_cnt = 32

name0=PD0

name1=PA0

name2=PA1

name3=PA2

name4=PA3

name5=PA4

name6=PA5

name7=PA6

name8=PA7

name9=PB0

name10=PB1

name11=PB2

name12=PB3

name13=PB4

name14=PB5

name15=PB6

name16=PB7

name17=PC0

name18=PC1

name19=PC2

name20=PC3

name21=PC4

name22=PC5

name23=PC6

name24=PC7

name25=PD0

name26=PD1

name27=PD2

name28=PD3

name29=PD4

name30=PD5

name31=PD6







 








EMI_TOOL/config/8266.ini

[common]

GPIO_CNT = 31

gpio  			 = 1

ie			 	 = 1

oen			 	 = 0 

output		 	 = 1

[ITEM0]

name 			 = "PA1"

gpio  			 = 586[1]  

ie			 	 = 581[1]  

oen			 	 = 582[1]  

output		 	 = 583[1]

[ITEM1]

name 			 = "PA4"

gpio  			 = 586[4]  

ie			 	 = 581[4]  

oen			 	 = 582[4]  

output		 	 = 583[4] 

[ITEM2]

name 			 = "PA5"

gpio  			 = 586[5]  

ie			 	 = 581[5]  

oen			 	 = 582[5]  

output		 	 = 583[5]  

[ITEM3]

name 			 = "PA6"

gpio  			 = 586[6]  

ie			 	 = 581[6]  

oen			 	 = 582[6]  

output		 	 = 583[6]

[ITEM4]

name 			 = "PA7"

gpio  			 = 586[7]  

ie			 	 = 581[7]  

oen			 	 = 582[7]  

output		 	 = 583[7]  

[ITEM5]

name 			 = "PB0"

gpio  			 = 58e[0]  

ie			 	 = 589[0]  

oen			     = 58a[0]  

output		     = 58b[0] 

[ITEM6]

name 			 = "PB1"

gpio  			 = 58e[1]  

ie			 	 = 589[1]  

oen			     = 58a[1]  

output		     = 58b[1] 

[ITEM7]

name 			 = "PB4"

gpio  			 = 58e[4]  

ie			 	 = 589[4]  

oen			     = 58a[4]  

output		     = 58b[4] 

[ITEM8]

name 			 = "PB7"

gpio  			 = 58e[7]  

ie			 	 = 589[7]  

oen			     = 58a[7]  

output		     = 58b[7]  

[ITEM9]

name 			 = "PC0"

gpio             = 596[0]  

ie			 	 = 591[0]  

oen		  		 = 592[0]  

output		 	 = 593[0]

[ITEM10]

name 			 = "PC1"

gpio             = 596[1]  

ie			 	 = 591[1]  

oen		  		 = 592[1]  

output		 	 = 593[1] 

[ITEM11]

name 			 = "PC2"

gpio             = 596[2]  

ie			 	 = 591[2]  

oen		  		 = 592[2]  

output		 	 = 593[2]  

[ITEM12]

name 			 = "PC3"

gpio             = 596[3]  

ie			 	 = 591[3]  

oen		  		 = 592[3]  

output		 	 = 593[3]

[ITEM13]

name 			 = "PC4"

gpio             = 596[4]  

ie			 	 = 591[4]  

oen		  		 = 592[4]  

output		 	 = 593[4]  

[ITEM14]

name 			 = "PC5"

gpio             = 596[5]  

ie			 	 = 591[5]  

oen		  		 = 592[5]  

output		 	 = 593[5] 

[ITEM15]

name 			 = "PC6"

gpio             = 596[6]  

ie			 	 = 591[6]  

oen		  		 = 592[6]  

output		 	 = 593[6]

[ITEM16]

name 			 = "PC7"

gpio             = 596[7]  

ie			 	 = 591[7]  

oen		  		 = 592[7]  

output		 	 = 593[7] 

[ITEM17]

name 			 = "PD0"

gpio 			 = 59e[0]

ie			 	 = 599[0] 

oen     		 = 59a[0]

output      	 = 59b[0]

[ITEM18]

name 			 = "PD1"

gpio 			 = 59e[1]

ie			 	 = 599[1] 

oen     		 = 59a[1]

output      	 = 59b[1]

[ITEM19]

name 			 = "PD2"

gpio 			 = 59e[2]

ie			 	 = 599[2] 

oen     		 = 59a[2]

output      	 = 59b[2]

[ITEM20]

name 			 = "PD3"

gpio 			 = 59e[3]

ie			 	 = 599[3] 

oen     		 = 59a[3]

output      	 = 59b[3]

[ITEM21]

name 			 = "PD4"

gpio 			 = 59e[4]

ie			 	 = 599[4] 

oen     		 = 59a[4]

output      	 = 59b[4]

[ITEM22]

name 			 = "PD5"

gpio 			 = 59e[5]

ie			 	 = 599[5] 

oen     		 = 59a[5]

output      	 = 59b[5]

[ITEM23]

name 			 = "PD6"

gpio 			 = 59e[6]

ie			 	 = 599[6] 

oen     		 = 59a[6]

output      	 = 59b[6]

[ITEM24]

name 			 = "PD7"

gpio 			 = 59e[7]

ie			 	 = 599[7] 

oen     		 = 59a[7]

output      	 = 59b[7]

[ITEM25]

name 			 = "PE0"

gpio			 = 5a6[0]

ie			 	 = 5a1[0] 

oen    			 = 5a2[0]

output			 = 5a3[0]

[ITEM26]

name 			 = "PE1"

gpio			 = 5a6[1]

ie			 	 = 5a1[1] 

oen    			 = 5a2[1]

output			 = 5a3[1]

[ITEM27]

name 			 = "PE2"

gpio			 = 5a6[2]

ie			 	 = 5a1[2] 

oen    			 = 5a2[2]

output			 = 5a3[2]

[ITEM28]

name 			 = "PE3"

gpio			 = 5a6[3]

ie			 	 = 5a1[3] 

oen    			 = 5a2[3]

output			 = 5a3[3]

[ITEM29]

name 			 = "PE4"

gpio			 = 5a6[4]

ie			 	 = 5a1[4] 

oen    			 = 5a2[4]

output			 = 5a3[4]

[ITEM30]

name 			 = "PE5"

gpio			 = 5a6[5]

ie			 	 = 5a1[5] 

oen    			 = 5a2[5]

output			 = 5a3[5]

[power_lever]

cnt = 11

name0   = 7dbm

name1	= 5dbm

name2   = 0dbm

name3   = -4.3dbm

name4   = -9.5dbm

name5   = -13.6dbm

name6   = -18.8dbm

name7   = -23.3dbm

name8   = -27.5dbm

name9   = -30dbm

name10  = -37dbm










EMI_TOOL/config/8267_8261.ini

[common]

GPIO_CNT = 33

gpio  			 = 1

ie			 	 = 1

oen			 	 = 0 

output		 	 = 1

[ITEM0]

name 			 = "PA0"

gpio  			 = 586[0]  

ie			 	 = 581[0]  

oen			 	 = 582[0]  

output		 	 = 583[0]  

[ITEM1]

name 			 = "PA1"

gpio  			 = 586[1]  

ie			 	 = 581[1]  

oen			 	 = 582[1]  

output		 	 = 583[1]  

[ITEM2]

name 			 = "PA2"

gpio  			 = 586[2]  

ie			 	 = 581[2]  

oen			 	 = 582[2]  

output		 	 = 583[2]  

[ITEM3]

name 			 = "PA3"

gpio  			 = 586[3]  

ie			 	 = 581[3]  

oen			 	 = 582[3]  

output		 	 = 583[3]  

[ITEM4]

name 			 = "PA4"

gpio  			 = 586[4]  

ie			 	 = 581[4]  

oen			 	 = 582[4]  

output		 	 = 583[4]  

[ITEM5]

name 			 = "PA5"

gpio  			 = 586[5]  

ie			 	 = 581[5]  

oen			 	 = 582[5]  

output		 	 = 583[5]  

[ITEM6]

name 			 = "PA6"

gpio  			 = 586[6]  

ie			 	 = 581[6]  

oen			 	 = 582[6]  

output		 	 = 583[6]  

[ITEM7]

name 			 = "PA7"

gpio  			 = 586[7]  

ie			 	 = 581[7]  

oen			 	 = 582[7]  

output		 	 = 583[7]  

[ITEM8]

name 			 = "PB1"

gpio  			 = 58e[1]  

ie			 	 = 589[1]  

oen			     = 58a[1]  

output		     = 58b[1]  

[ITEM9]

name 			 = "PB2"

gpio  			 = 58e[2]  

ie			 	 = 589[2]  

oen			     = 58a[2]  

output		     = 58b[2]  

[ITEM10]

name 			 = "PB3"

gpio  			 = 58e[3]  

ie			 	 = 589[3]  

oen			     = 58a[3]  

output		     = 58b[3]  

[ITEM11]

name 			 = "PB4"

gpio  			 = 58e[4]  

ie			 	 = 589[4]  

oen			     = 58a[4]  

output		     = 58b[4]  

[ITEM12]

name 			 = "PB5"

gpio  			 = 58e[5]  

ie			 	 = 589[5]  

oen			     = 58a[5]  

output		     = 58b[5]  

[ITEM13]

name 			 = "PB6"

gpio  			 = 58e[6]  

ie			 	 = 589[6]  

oen			     = 58a[6]  

output		     = 58b[6]  

[ITEM14]

name 			 = "PB7"

gpio  			 = 58e[7]  

ie			 	 = 589[7]  

oen			     = 58a[7]  

output		     = 58b[7]  

[ITEM15]

name 			 = "PC0"

gpio             = 596[0]  

ie			 	 = 591[0]  

oen		  		 = 592[0]  

output		 	 = 593[0]  

[ITEM16]

name 			 = "PC1"

gpio             = 596[1]  

ie			 	 = 591[1]  

oen		  		 = 592[1]  

output		 	 = 593[1]  

[ITEM17]

name 			 = "PC2"

gpio             = 596[2]  

ie			 	 = 591[2]  

oen		  		 = 592[2]  

output		 	 = 593[2]  

[ITEM18]

name 			 = "PC3"

gpio             = 596[3]  

ie			 	 = 591[3]  

oen		  		 = 592[3]  

output		 	 = 593[3]  

[ITEM19]

name 			 = "PC4"

gpio             = 596[4]  

ie			 	 = 591[4]  

oen		  		 = 592[4]  

output		 	 = 593[4]  

[ITEM20]

name 			 = "PC5"

gpio             = 596[5]  

ie			 	 = 591[5]  

oen		  		 = 592[5]  

output		 	 = 593[5]  

[ITEM21]

name 			 = "PC6"

gpio             = 596[6]  

ie			 	 = 591[6]  

oen		  		 = 592[6]  

output		 	 = 593[6]  

[ITEM22]

name 			 = "PC7"

gpio             = 596[7]  

ie			 	 = 591[7]  

oen		  		 = 592[7]  

output		 	 = 593[7] 

[ITEM23]

name 			 = "PD0"

gpio 			 = 59e[0]

ie			 	 = 599[0] 

oen     		 = 59a[0]

output      	 = 59b[0]

[ITEM24]

name 			 = "PD1"

gpio 			 = 59e[1]

ie			 	 = 599[1] 

oen     		 = 59a[1]

output      	 = 59b[1]

[ITEM25]

name 			 = "PD2"

gpio 			 = 59e[2]

ie			 	 = 599[2] 

oen     		 = 59a[2]

output      	 = 59b[2]

[ITEM26]

name 			 = "PD3"

gpio 			 = 59e[3]

ie			 	 = 599[3] 

oen     		 = 59a[3]

output      	 = 59b[3]

[ITEM27]

name 			 = "PD4"

gpio 			 = 59e[4]

ie			 	 = 599[4] 

oen     		 = 59a[4]

output      	 = 59b[4]

[ITEM28]

name 			 = "PD5"

gpio 			 = 59e[5]

ie			 	 = 599[5] 

oen     		 = 59a[5]

output      	 = 59b[5]

[ITEM29]

name 			 = "PD6"

gpio 			 = 59e[6]

ie			 	 = 599[6] 

oen     		 = 59a[6]

output      	 = 59b[6]

[ITEM30]

name 			 = "PD7"

gpio 			 = 59e[7]

ie			 	 = 599[7] 

oen     		 = 59a[7]

output      	 = 59b[7]

[ITEM31]

name 			 = "PE0"

gpio			 = 5a6[0]

ie			 	 = 5a1[0] 

oen    			 = 5a2[0]

output			 = 5a3[0]

[ITEM32]

name 			 = "PE1"

gpio			 = 5a6[1]

ie			 	 = 5a1[1] 

oen    			 = 5a2[1]

output			 = 5a3[1]

[power_lever]

cnt = 11

name0   = 7dbm

name1	= 5dbm

name2   = 0dbm

name3   = -4.3dbm

name4   = -9.5dbm

name5   = -13.6dbm

name6   = -18.8dbm

name7   = -23.3dbm

name8   = -27.5dbm

name9   = -30dbm

name10  = -37dbm
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